
Patchwork Explorer 2025 X8
USER MANUAL



TABLE OF CONTENTS
Introduction ................................................................................................................................  5

Products .....................................................................................................................................  6
Compatible Files .......................................................................................................................... 6
Loading an Individual Product ..................................................................................................... 6
Multi-KDR ..................................................................................................................................... 7
Loading Multiple Products Simultaneously ................................................................................. 8

Loading Multiple Products in Separate Viewports .............................................................. 8
Loading Multiple Products in a Single Viewport .................................................................. 8

Tools .........................................................................................................................................  10
View Manager ............................................................................................................................ 10
Navigation .................................................................................................................................. 10
Viewport Configuration .............................................................................................................. 12

Settings ....................................................................................................................................  13
General ....................................................................................................................................... 13
Display ........................................................................................................................................ 14
Stereo ......................................................................................................................................... 15

Visualization Settings ...............................................................................................................  16
Rendering ................................................................................................................................... 18
Animation ................................................................................................................................... 18
Linking Viewports ...................................................................................................................... 18

Editors ......................................................................................................................................  20
Product Manager ....................................................................................................................... 20

List of Products in a Viewport ............................................................................................ 20
Render Options ................................................................................................................... 21
Properties Tab .................................................................................................................... 21
Master Properties Tab ....................................................................................................... 22
Cameras Tab ...................................................................................................................... 22
Configuration Tab ............................................................................................................... 22
Animation Tab .................................................................................................................... 23

Stereo (Editor) ............................................................................................................................ 23
Real-Time Sun (Editor) ............................................................................................................... 23

Sun Settings Box ................................................................................................................ 24
Shadow Settings Box ......................................................................................................... 26
North Setting Box ............................................................................................................... 27
Position Box ....................................................................................................................... 27

Manual Tab ................................................................................................................. 28
Date, Time and Location Tab ..................................................................................... 28
Extracted from Environment Tab ............................................................................... 28

Clipping Planes (Editor) ............................................................................................................. 29
General Settings for Clipping Planes ................................................................................. 29
Settings for the Selected Plane .......................................................................................... 30

Creating a Contour ..................................................................................................... 30
Additional Display Options ......................................................................................... 30

Measuring Tool .......................................................................................................................... 32

Patchwork Explorer 2025 X8

2



Snapshot (Editor) ....................................................................................................................... 32
Dimensions Zone ............................................................................................................... 32
Rendering Engine Window ................................................................................................. 33
Files Zone ........................................................................................................................... 33

Compression .............................................................................................................. 34
Layered Image Options .............................................................................................. 34

Snapshot Zone ................................................................................................................... 35
Internal Render Info Zone .................................................................................................. 35

Videos (Editor) ........................................................................................................................... 35
Dimensions Zone ............................................................................................................... 36
Files Zone ........................................................................................................................... 36
Rendering Engine Window ................................................................................................. 37
Snapshot Zone ................................................................................................................... 37
Internal Render Info Zone .................................................................................................. 37
Frame Output Zone ............................................................................................................ 37
Camera Path Zone ............................................................................................................. 38

Rotor Type .................................................................................................................. 38
Kam File Type ............................................................................................................. 38
Bookmark Animator Type .......................................................................................... 39
Bookmark ................................................................................................................... 40

VR Object Editor ......................................................................................................................... 42
Dimensions Zone ............................................................................................................... 42
Files Zone ........................................................................................................................... 42
Rendering Engine Window ................................................................................................. 43
Snapshot Zone ................................................................................................................... 43
Internal Render Info Zone .................................................................................................. 43
Preview Frame Zone .......................................................................................................... 44
Camera Path Zone ............................................................................................................. 44
VR Object Settings ............................................................................................................. 44

Cubic VR Panorama Editor ......................................................................................................... 44
Dimensions Zone ............................................................................................................... 45
Files Zone ........................................................................................................................... 45
Rendering Engine Window ................................................................................................. 46
Snapshot Zone ................................................................................................................... 46
Internal Render Info Zone .................................................................................................. 46

Favorite cameras ......................................................................................................................  47

Required Hardware ...................................................................................................................  48
64-bit Architectures .................................................................................................................... 48
Minimal Configuration ................................................................................................................ 48
Recommended Configuration .................................................................................................... 48

Patchwork Explorer 2025 X8

3



Version: 20250814.0346

© Lumiscaphe SA, 2001-2025

Headquarters:

Espace France
4 voie Romaine
33610  Canéjan
France

Documentation lead: P. Peyrevidal

Reproduction, extraction, presentation, alteration, modification, or use, whether in whole or in part, of
this documentation or any of its elements whatsoever, by whatever means or for whatever purpose, and
more generally any act that has not been explicitly authorized by Lumiscaphe are strictly forbidden and
subject to prosecution.

Trademarks, brands, brand names, service marks, logos, and other distinctive symbols displayed in
this documentation are property of their respective owners and are protected by French and European
legislation, as well as by other applicable legislation. All unauthorized use or reproduction is strictly
prohibited.

This software uses libav 13 (see LGPL 2.1). More info at libav.

The Libav library under Lesser General Public License (LGPL 2.1) and its source code can be downloaded
here.

This documentation is provided with the software Patchwork Explorer. It does not, however, constitute a
contractual agreement with regard to the features and functionality of the software.

Patchwork Explorer 2025 X8

4

https://github.com/libav/libav
https://resources.lumiscaphe.com/Resources/LGPL/org.libav.v13.20180816.zip
https://resources.lumiscaphe.com/Resources/LGPL/org.libav.v13.20180816.zip


INTRODUCTION

The software Patchwork Explorer offers an interactive presentation of 3D Digital Aspect Mockups cre-
ated with the Patchwork 3D authoring software, as well as the exploration of product configurations.
This program is designed to be simple and requires no knowledge of 3D rendering.

NOTE
Patchwork Explorer is available in several editions Enterprise, Premium and Community
tailored to your needs.

Patchwork Explorer Community is a full software and free to use for non-commercial use.

Patchwork Explorer Premium, for its part, is intended for commercial use. You must acquire a Patchwork
Explorer Premium license to use it.

NOTE
Note that Premium and Community editions have their own unique file version. These
two editions can work together. On the other hand, a file created and/or exported from
Patchwork 3D Enterprise cannot be opened or read with Patchwork Explorer Premium or
Community.

Thanks to Patchwork Explorer you can:

• View your products in 3D.
Patchwork Explorer provides a 3D visualization space called a “Viewport” that allows you to interac-
tively inspect a product’s design. Tools such as the real-time sun contribute to the creation of an
ultra-realistic appearance.

• Compare different 3D products or different configurations of a single product.
Several viewport configurations [12] are available for viewing products side by side. This approach
allows several elements in a range of products to be compared at the same time. The ability to link
viewports [18] is included to facilitate comparisons in 3D.

• Manage your 3D layouts: set up a layout and save your set-ups.

Load several products in the same Viewport [8], specify the position of your products and their config-
uration [22], and determine the rendering. When you’ve finished preparing a layout, Patchwork Explorer
allows you to save them as a .kpl file format [21] which can be reloaded at any time.
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PRODUCTS

Compatible Files
Patchwork Explorer is compatible with the KDR file format.

Loading an Individual Product
Access: File menu > Open

Begin by importing a file. Once a file is opened, the floating window Viewport Manager is displayed on
the screen. This window contains thumbnail views of the products in your file.

To load a product, drag and drop its thumbnail onto a viewport. You can also load a product in the active
viewport by double clicking the thumbnail.

Access: View Manager window > Drag and drop
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Drag and drop a product onto a viewport. (Enterprise edition)

Once a product has been loaded, it is possible to hide individual surfaces. Right-click within the viewport
and choose Click to hide. This activates the Click to hide mode. When a surface is clicked, it is hidden.
To restore the visibility of hidden surfaces, right-click within the viewport and choose Show all. To exit
Click to hide mode, right-click within the viewport and choose Click to hide again.

Multi-KDR
Opening several KDR files is possible thanks to the “multi-KDR” mode in Patchwork Explorer.

With the “multi-KDR” mode, you can add products from other databases to the list of products available
in the Viewport Manager.

When the "multi-KDR" mode is deactivated, the list of products available in the View Manager is limited to
the products in your KDR file. Once the "multi-KDR" mode is activated, you can add products from other
databases to this list.

This gives you the possibility to stage together or compare side by side products found in different KDR
files.

To add products from a different database, return to the File menu to open a new database. Products in
this new database will be added to the list of products available in the Viewport Manager.
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Loading Multiple Products Simultaneously
Patchwork Explorer is designed to explore multiple products and multiple databases at the same time.
You can either load different products in separate viewports in order to compare them or load multiple
products in the same viewport to create a layout.

The products are available in the Viewport Manager [10] as soon as a database is opened. You can also
add products from other databases thanks to the multi-KDR mode.

Loading Multiple Products in Separate Viewports

Access: View Manager window > Drag and drop

When launched, Patchwork Explorer shows a single viewport. However, up to four viewports and several
viewport distributions are available. In order to load multiple products, each in its own viewport, change
your viewport configuration. Refer to the chapter Viewport Configuration [12] for more information.

Drag and drop the product that you want to load onto the desired viewport. You can also load a product
in the active viewport by double-clicking.

TIP
If the viewport already contains a product, a drag-and-drop or a double click will replace
the product currently loaded in the viewport with the product you are loading. An alert
prevents you from accidentally replacing the products in a viewport if more than one
product is already loaded in that viewport.

You can link viewports (see the chapter on Linking Viewports [18]) to synchronize the
manipulation of the products in the linked viewports.

Loading Multiple Products in a Single Viewport

Access: Viewport Manager window > Ctrl + Drag and Drop

To load multiple products in the same viewport, begin by loading the first product normally (drag-and-
drop or double-click). This product will become the main product or the “master” product. The “master”
product is the product with the environment attributes and post-processing that you want to apply to
your scene. Regardless of the order in which you load your products, you are free to modify the “master”
product at any time in the Product Manager [20].

Load multiple products by holding down the Ctrl key while dragging and dropping the subsequent
products onto the viewport. You can load multiple instances of a single product, multiple products from
a single file, or products from various databases if you have opened multiple databases.

Additional products will be placed at the point onto which they are dropped. You can place a product
on the reference grid's plane, or on a surface of another product in the layout. If the cursor points to
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another product's surface when you drop the product you are adding, the new product will be placed on
that surface. In this case, the new product's pivot will be oriented so that its Y-axis ("up") is aligned with
the surface's normal. Pivot placement and orientation, as well as the recalculation of surface normals,
must be set in Patchwork 3D Enterprise or Patchwork 3D Engineering prior to exporting the products.

The position and the orientation of the products in a layout can be modified once the product has been
loaded. To do this, use the translation and rotation gizmos. These gizmos are available:

• in the Navigation box [10] of the Viewport Manager,

• in the Viewport menu,

• in the Transformation box of the Properties tab [21] in the Product Manager.

TIP
Don't forget to save the layout of the scene that you're creating. Ctrl+S will save the layout
as a .kpl file.
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TOOLS

View Manager
Access: Editors menu > Viewport Manager

keyboard shortcut: M

The floating Viewport Manager window appears when a KDR file is opened.

This window includes the list of products contained in the imported database, as well as the functions
relative to the products, the organization of the viewports, and the position of the point of observation.

Navigation
Access: Viewport Manager window

Mode menu

To display even the smallest details of a product, Patchwork Explorer includes a range of navigational
tools. These tools are available in the Viewport Manager or in the Mode menu in the main window.

The product is always observed from a freely-defined point of view. These tools will help you position
this observational point as efficiently and precisely as possible.

The look-at point determines the direction in which the camera is directed. The observational point
designates the location of the camera in the scene.

The available navigational tools are listed in the following table:

Icon Tool Description
Select A product in the scene can be selected by clicking on it. The corners

of a box enclosing the selected product appear. This indicates
which product is included in the selection. 

Zoom The look-at point remains fixed and the observational point shifts
along the direction of observation.

Pan The observer moves laterally along the observation plane.

Orbit The observational point revolves around a fixed look-at point.

Fly Mode The look-at point and the observational point both advance in the
direction of observation.
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Icon Tool Description
Walk Mode The look-at point and the observational point both advance in the

direction of observation, but the observational point remains at a
fixed altitude.

Translation
gizmo

The product (or group of selected products) can be positioned by
direct manipulation of the translation gizmo.

Rotation gizmo The product (or group of selected products) can be oriented by
direct manipulation of the rotation gizmo.

Focal This mode reproduces the setting of the focal length of a camera.

Roll The product turns with regard to the center of the screen.

Zoom to fit The observational point is positioned in order to show the entirety
of the product while preserving the direction of observation.

Collisions The camera’s ability to pass through all surfaces in a scene is
blocked when this option is activated. To observe the effects of
this option, use fly mode or walk mode.

Prevent
Collisions with
Transparent
Surfaces

The camera’s ability to pass through transparent surfaces only is
activated. (Available only if Collisions is activated.)

NOTE
Keyboard shortcuts allow quick access to the first three navigational modes:

• Zoom: Ctrl + Shift + Middle Mouse Button / move the mouse

• Pan : Hold down the mouse wheel / move the mouse

• Orbit: Ctrl + Middle Mouse Button / move the mouse

Use Ctrl+Space to place the viewport’s look-at point at the position indicated by the mouse pointer.

Use Shift+Space to set the depth of field and bring the surface under the mouse pointer into focus.
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Viewport Configuration
Access: Viewport Manager window

Viewport menu > Viewport Layout

The main function of Patchwork Explorer is the comparison of different versions of your products.
Patchwork Explorer provides the tools that allow the main viewport to be divided into several viewports,
all while preserving the real-time interactivity of each viewport.

Icon Option Description
Maximize
Active
Viewport

Displays the active viewport in 1x1. Rediscover the products and
configurations in the other viewports by clicking a second time on this
button. This function can also be found in the Viewport menu.

Clear Inactive
Viewports

Displays the active viewport in 1x1 and deletes the products and
configurations in the other viewports. This function can also be found
in the Viewport menu.

Clear All
Viewports

Closes the products and configurations in all of the viewports. This
function can also be found in the Viewport menu.

Product
Manager

Displays the Product Manager (see Product Manager [20]). This
option is also available from the Viewport menu.

Live Mode This option, which is also available in the Viewport menu, will function
if your database contains triggered animations. The animations and
triggers must be previously defined in Patchwork 3D Enterprise or
Patchwork 3D Engineering. Activate this mode, then click on the
triggers in your product.

TIP
To exit Live Mode, press the Esc key.
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SETTINGS

Access: File menu > Settings

You can establish and modify the rules of operation for Patchwork Explorer in the Settings window.

The software settings are grouped into three tabs: General, Display, and Stereo.

General
The General tab includes options that set the presentation of the interface.

The General tab of Settings.

Choose a language from the drop-down menu in the first zone. The software is available in French and
English. To apply the modification of this setting, restart the program.

The Graphical Interface zone allows you to Remember size of windows and to select your Theme. The
theme options are dark (default) and cartoon. To apply the modification of this setting, restart the
program.

In the Recent Database List, enter the maximum number of databases that you wish to be able to open
from the File > Recent submenu. This maximum number can be anything from 0 to 99.

The final zone, Controllers, concerns the mouse. It contains a single option, Enable Space Mouse. To
apply the modification of the setting, restart the program.
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Display

The Display tab of Settings.

The zone Antialiasing sets the behavior of the antialiasing system of the software that removes the
aliasing effects on the images.

The Wait Time field provides the delay at the end of which the antialiasing is applied, counting from the
moment when there is no more user activity in the software.

When the Incremental checkbox is ticked, the different phases of the antialiasing are visible on the
screen. When this checkbox is left empty, Patchwork Explorer runs all of the antialiasing calculations
before showing the result.

Depending on your graphics card, it is also possible to activate hardware antialiasing, with a variety of
settings (deactivated, 2x, 4x, 8x, 16x, 32x, 64x).

In the Mesh Optimization zone, the option Store meshes in graphics card sets the means of preparing
the rendering. When this option is activated, the graphics card’s memory is used whenever possible. This
option improves the speed of rendering for databases. This option is activated by default.

The zone Default Stereo Values sets the default values for the Stereo Editor. For additional options
concerning stereo, see the information on the Stereo [15] tab.

In the Display Properties zone, verify the dimensions of your screen in order to display the post-process-
ing and other 2D effects on a 1:1 scale.

The option Always Use Main Screen Resolution for 3D Display, which is selected by default, restricts the
dimensions of 3D viewports to the dimensions of your main screen. This limitation is useful when the
screen used for set-up and the screen used for demonstration do not use the same resolution, which is
the case, for example, when you use a laptop to manage a separate presentation screen.
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The Color Management Profile is detected automatically by default. In this zone, you can also provide a
specific value chosen from the drop-down list.

The zone Real-Time Sun Configuration sets the maximum size of the buffers for shadows generated by
the real-time sun. Provide the maximum values in pixels. A higher value will cause slower rendering. To
apply the modification of this setting, restart the program.

For other real-time sun parameters, refer to the chapter.

Stereo
In the Stereo tab, you have control over the settings for viewing your product in 3D.

The Stereo tab of Settings.

The Parameters zone concerns the measurements associated with the screen, the user, and their relative
positions. The values provided by default are modifiable. You can adjust:

• The Width of the screen in meters,

• The Height of the screen in meters,

• The Distance to Screen in meters (position of the user),

• The Vertical Eye Offset in meters (position of the user’s eyes with regard to the bottom border of the
screen),

• The Interocular Distance of the user in meters.

The choice of options in the zone Full Screen Policy determines which screen is used for display in full
screen mode in the case of the use of multiple screens.
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VISUALIZATION SETTINGS

Access: Visualization menu

Patchwork Explorer offers options to personalize the display in the active viewport.

Icon Option Description
Mirror Effect Enables or disables the mirror effect, if your database contains one, in

the active viewport. This effect can be set up in the post-processing
options in Patchwork 3D Enterprise or Patchwork 3D Engineering.

Software
Antialiasing

Enables or disables Patchwork Explorer’s antialiasing. This option
does not impact the hardware antialiasing settings defined in
the Display tab of the Settings editor.

Full Screen
Mode

Shows the active viewport in full screen.

Grid Enables or disables the display of the grid in the active viewport.

Axis
Orientation

Enables or disables the display of the X, Y, and Z-axis orientation
indicator in the active viewport.
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Icon Option Description
Show
Statistics

Enables or disables the display of the rendering statistics in the active
viewport. This option displays data related to rendering delays, the
number of surfaces, summits, and triangles processed, and the GPU
memory used.

The consumption of GPU memory is displayed as a gauge for the
following elements:

• The images and videos used as textures and rendered in the active
viewport,

• The meshes rendered in the active viewport,

• The textures used to calculate relief (bumpmaps) that are rendered
in the active viewport,

• The lighting environments rendered in the active viewport,

• The lightmaps calculated in Shaper and used during the rendering in
the active viewport,

• Other: other sources of GPU memory consumption, including
database resources that are not used in the active viewport, other
open software, and the memory reserved by the graphics card's
driver,

• Free: unused GPU memory.

The following data is provided when the display of the statistics is
enabled:

• fps (frames per second),

• Image Preparation time,

• Image Render time,

• Image Finalization time,

• Number of Surfaces rendered,

• Number of Vertices rendered,

• Number of Triangles rendered.
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Rendering
Access: Viewport menu > Render by Type

Viewport menu > Render

You can restrict the rendering to one or several types of materials through the menu Viewport > Render
Type. In this submenu, the types of materials are indicated with a checkmark if they are rendered. By
default, all of the types of materials are selected. To deactivate the rendering of a type of material, select
it from the list. The modifications are shown on the product in the active viewport.

The elements available in the menu Viewport > Render allow you to access different rendering modes.
By default, Patchwork Explorer calculates your image in Material mode. However, you have the choice
among the modes Wireframe, Fill, UV, Lightmap, Material, and Mix.

Animation
Access: Mode menu > Live Mode

The option Live Mode switches the interface of Patchwork Explorer to a mode in which animations
based on keyboard or mouse shortcuts can be read. Opening a car door, for example, might be triggered
by clicking directly on it.

This mode is operational when your database includes animations with triggers. Animations and triggers
must be previously defined in Patchwork 3D Enterprise or Patchwork 3D Engineering.

TIP
To exit Live Mode, press the Esc key.

Linking Viewports
Access: Viewport menu > Link

To facilitate the comparison of products shown in different viewports, Patchwork Explorer employs a
method of synchronization of multiple viewports (interactive comparison). If this linking method is ac-
tive, the observational point in the inactive viewports will be updated to correspond to any modifications
to the observational point in the active viewport.

You can choose from different link modes:
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Icon Mode Description
None The observational point is never updated.

All The observational point is always updated in all viewports.

Model The observational point is updated in viewports with the same
model. All of the products based on the same model are updated
to be viewed from the same position.

Link Interactively This option allows the observational point to be dynamically and
instantaneously synchronized in accordance with the chosen link
mode.

For complex scenes, this interactive synchronization hinders the fluidity of movement. When the Link
Interactively option is deactivated, the synchronization takes effect once the interactive phase of modifi-
cation has ended.

NOTE
The default link settings use the Model mode and the Link Interactively option is deactiva-
ted.
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EDITORS

Access: Editors menu

Capture editors configure the settings needed to generate still images or videos. These editors export
files in the standard image or video formats.

The interface has four capture editors: the Capture Editor fixed, the Video Editor, the VR Object Editor,
and the Cubic VR Panorama Editor.

Product Manager
Access: Editors menu > Product Manager

The Product Manager is the basic construction tool for creating layouts. Using it, you can set up
products, establish their configuration, and determine their position in the active viewport.

List of Products in a Viewport

The Product Manager displays the products present in the active viewport at the top of the editor. In this
zone, there are several buttons:

Icon Function Description
Add Group Creates a new product group. Products listed in this zone can be

added to the group by drag-and-drop.
Delete Group Deletes the selected group.

Set as Master Defines the selected product as the one that provides the environment
and post-processes for the active viewport.

Load Layout Opens a set of products that have been previously set up and saved.

Save Layout Saves the current set of products.

Delete Product Deletes the selected product from the list and from the active
viewport.

The  icon indicates that the product or the group is visible. The  icon indicates that it is hidden. Click
on the icon to change the visibility state.

In the Product zone, the name of the currently selected product is shown. You can rename the product
by typing directly in this field. This is particularly helpful when working with a layout containing multiple
examples of a single product.
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The checkbox to the left activates or deactivates the visibility of this product in the viewport. To the right,
if the product is the “Master” in the viewport, this state is indicated.

Render Options
Below the product tabs is the Render zone. In the Render zone, you can enable or disable the options to:

Option Description
Use Enhanced
Transparency

Enhanced transparency provides improved rendering for transparent surfaces,
particularly for complex transparent surfaces, intersecting transparent
surfaces, and transparent surfaces that surround other surfaces. Rather
than using surfaces' bounding boxes to determine their distance from
the viewpoint, enhanced transparency utilizes pixel-by-pixel analysis to
determine the order in which the surfaces must be rendered. Using enhanced
transparency increases the consumption of GPU memory and reduces the
number of images per second. This option applies to the entire scene.

Place Dropped
Products Under
Cursor

If your software version contains the "Layout" option, you can add products to
the scene by drag-and-drop. Keep this option checked in order to place new
products at the location of the cursor when you release the mouse button to
drop them. If this option is not enabled, dropped products will be placed at the
3D world's origin.

Properties Tab
The Properties tab contains the parameters regarding the product and its position in the viewport.

The Transformation zone allows for the specification of the coordinates in the world frame of reference
for the selected product or model’s position (TX, TY, and TZ) and orientation (RX, RY, and RZ). The
position coordinates are expressed in meters and the orientation coordinates in degrees. Enter the
numerical values or click on the gizmo icons to modify your product’s position and orientation.

A final parameter, Rebuild dynamic environments, sets the conditions that control the automatic updating
of local environments when the displayed configuration is modified. The product displayed must contain
dynamic local environments for this parameter to have an effect.

Condition Description
Never Never allow dynamic updating of local environments when configuration changes

are made. If rendering fluidity is more important than photorealism, use this option
to avoid the slight delay in recalculation for larger or complex scenes.

Product only Allow dynamic updating of local environments when configuration changes are
made to the product containing dynamic local environments. If your software
version contains the option "Layout" and you are viewing a multi-product scene,
configuration changes affecting other products in the scene will not cause dynamic
updating.

In layout If your software version contains the option "Layout" and you are viewing a multi-
product scene, allow dynamic updating of local environments when configuration
changes are made to any product in the scene.
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Master Properties Tab
The Master Properties tab contains the parameters regarding the product display options. If your
software version contains the "Layout" option and you are viewing a multi-product scene, the options
concern the "Master" product that imposes certain parameters on the scene.

Option Description
Use background Display the background of the current camera sensor. If you are viewing a

multi-product scene, this applies to the "Master" camera sensor only.
Use Overlay Display the overlay of the current camera sensor. If you are viewing a

multi-product scene, this applies to the "Master" camera sensor only.
Use Post-
Processing

Display the post-processing blend of the current camera sensor. If you are
viewing a multi-product scene, this applies to the "Master" camera sensor
only.

Show Global
Environment

Use the global lighting environment of the current product. If you are
viewing a multi-product scene, the "Master" global environment will be used
for all products.

Show Surface
using Environment
Material

This option is used to show or hide surfaces using the environment
material in the "Master" product, such as a skydome. These surfaces are
visible by default but can be hidden by unchecking this option.

Cameras Tab
If favorite cameras were defined in your product, you will find them in the Cameras tab.

The cameras are shown in the Camera box. Click on the name of a camera to call it up in the viewport.
This will also apply the background, post-processing effects, and overlay, if any are associated with the
camera's sensor. Prevent the background, post-processing effects or overlay from being displayed in the
Master Properties tab.

The name of the current camera is displayed in the upper left-hand corner of the viewport. Right-click on
the name of the camera to open a context menu listing the cameras of the "Master" product. Select a
new camera from this list to change the current camera.

TIP
The four favorite cameras are also available in the Product menu.

NOTE
You can place multiple products in the same viewport. In this case, only the camera
sensors for the "Master" product are used. Calling up cameras for other products loads the
camera position and orientation only.

Configuration Tab
Patchwork Explorer takes advantage of product configuration if it is present in the imported KDR file. The
software thus offers the ability to easily explore all of the possible product combinations.
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Configuration settings are displayed when the active product has configurable elements. To change the
product configuration, modify these settings using the checkboxes and the drop-down lists.

Display of multiple product configurations is also possible for configurable products. See Loading Multi-
ple Products Simultaneously [8].You can also place a configurable product multiple times in a viewport
and configure each of these products independently. You can thus compose your scene with several
variations of the same product or compare these product variations in separate viewports.

Animation Tab
If animations have been defined for your product, the Animation tab will be present.

Manage the playback of the animation with the following tools:

Option Description
Timeline From the drop-down list, select the preset animation timeline you want to play.
Timeline
Scrollbar

Positions the rectangular cursor at any point on the bar to display the
corresponding animation state. For increased precision, you can also provide
the time in seconds in the field to the right of the slider.
Places the cursor at the beginning of the animation.

Initiates the animation playback from the cursor’s current position or pauses
the playback if the animation is currently playing.
Places the cursor at the end of the animation.

Activates or deactivates looped playback.

Stereo (Editor)
Access: menu Editors > Stereo

The stereo editor offers quick access to the stereo settings. The default values are defined in the Stereo
Default box of the Display [14] tab of the Settings window.

To modify the stereo display settings, stereo vision must be activated from Visualization > Activate
Stereo Vision.

To find additional stereo settings, go to File > Settings > Stereo [15] tab.

Real-Time Sun (Editor)

Accessible in: Editors >  Real-Time Sun
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Real-Time Sun is an editor used to set up and display a sun that can be modified in real time in your
products.

Example of real-time sun usage.

This editor is composed of four boxes: Sun Settings, Shadow Settings, North Setting, and Position.

Sun Settings Box
The Sun Settings box provides a set of adjustable parameters for creating a real-time sun.

Parameter Description
On Check the On box to activate the real-time sun in your product.
Color Click on the Color box to open the color chooser and pick the color to assign to the

sun.
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Parameter Description
Intensity Enter in this field the value of the desired intensity of the sun. This value must be

positive. Unlike the sun type lightings available in the Shaper module, intensity is
adjusted according to the sun altitude.

Example of sun intensity variation.

NOTE
Real-time sun lighting is added linearly to the existing lightmaps in
the model. If your model has very bright lightmaps, the effects of the
sun will not be as visible.

Shadow
intensity

By default, no light intensity is added to areas which are not sunlit. However, by
entering a value in the Shadow intensity field, you can apply an additional light
intensity in these shadow areas. The value entered must be positive. The value 0
corresponds to a realistic effect.

Example of shadow intensity variation.
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Parameter Description
Lightmap
modulator

Adding a real-time sun to the lightmap of a product can produce an intensity of
a lightmap that is too strong. If this is the case, you can modify the intensity of
the lightmap. The field Lightmap modulator is used to set a modulation coefficient
for the intensity of the lighting calculated in the Shaper module. The value of
this coefficient must be between 0 and 1. The value 0 assigns a null intensity to
the lightmap. The value 1 corresponds to the assignment of the lightmap as it is
calculated in the Shaper module.

Specular Tick this check box to display the sun’s specular reflection on your product. Enter
its intensity in the corresponding field.

Example of a scene without and with the sun’s specular reflection.

Shadow Settings Box
Parameters specific to shadows are included in this box.

Setting Description
Shadows in
mirrors

Tick this check box to display shadows on reflective surfaces. The activation
of this option extends the rendering time.

Shadow quality Select the quality of shadows to display from the drop-down menu. The
higher the selected quality is, the longer the rendering time will be.
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Setting Description
Shadow
smoothness

Select the width for the blur effect on shadow edges from this drop-down
menu. The more the shadows are smoothed, the longer the rendering time
will be.

Examples of different smoothness in shadows.

North Setting Box
The North Setting box is used to set up the north relative to the reference axis of the database. There are
three ways to set up the north direction:

• By entering a value between 0 and 360° for the angle between the X axis and the North arrow of the
compass,

• By clicking on the compass while holding the left button of the mouse, and dragging it to the desired
position,

• By clicking on the grid to define the orientation of the compass.

Positioning the compass at a 20.2° angle between the x axis and the compass.

Position Box
The Position box consists of three tabs, one for each sun positioning mode.
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Manual Tab
This tab proposes to position the sun by entering a value for the Azimuth and the Altitude, or directly with
the widgets by clicking or moving the sun to the desired position.

The Manual tab.

Azimuth is the angle in the horizontal plane between the sun direction and the north.

Altitude is the angle between the sun direction and its projection onto the horizontal plane.

Date, Time and Location Tab
This tab allows the sun to be located so as to mimic its position in the sky at a given date and time for
a specific location. To do this, select or enter the date and time of your choice in the corresponding data
field. Then provide the time zone with the drop-down menu. Areas of the world in darkness are updated
on the map.

To activate the shift for daylight saving time, check the Daylight savings box and enter the value in
minutes of the desired shift. This is only active on days when daylight saving time is applicable (from the
last Sunday of March to the last Sunday of October).

Next, specify your location of choice:

• By entering values for latitude and longitude in the data fields – the City field then displays User-
defined,

• By selecting a city in the City drop-down menu, or

• By clicking directly on a point on the map – the City field also displays User-defined.

Extracted from Environment Tab
Select this tab to position the sun at the point defined as the brightest point in the product environment.
This point must be previously established in Patchwork 3D Enterprise or Patchwork 3D Engineering.
(Refer to the documentation of Patchwork 3D Enterprise or Patchwork 3D Engineering. This operation
is described in the chapter on the Environment’s Brightest Point box of the Product Environments
Properties tab of the Product Environments editor.)
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Clipping Planes (Editor)

NOTE
This feature requires a specific license option and may not be available in your software
version.

Accessible in: Editors > Clipping planes

Clipping Planes is an editor that allows you to section the object of the scene in a pre-designated plane
in order to see its interior.

Active clipping planes are visible in all open viewports and will clip through all products.

NOTE
Clipping planes are positioned in the world. Consequently, modifying the position of a
geometry in the world will not move the plane. The position at which the plane clips the
element will be modified.

General Settings for Clipping Planes
The General Options zone provides render settings with the Face Elimination Policy function, which
allows you to show or to hide the backfaces of the surfaces.

In the Face Elimination Policy drop-down list, the option Surfaces displays backfaces according to the
settings provided in the Surface Properties in Shaper.

The Show Gizmo option displays a translation gizmo that can be manipulated to quickly move the plane
of the active section.
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The Tags section can be used to prevent surfaces from being clipped by the plane. Use the button to
open a list of tags; select the tag that marks the surfaces that should not be clipped. Tags are assigned
to surfaces using the Tag Manager in Shaper.

Patchwork 3D Design allows the management and display of several Clipping planes simultaneously.
Each plane is listed separately, followed by indicators for the clipping plane's state (enabled or disabled),
the visibility of its contour, and the visibility of its grid. Clicking on the indicators modifies the state of the
associated property.

Settings for the Selected Plane
The Enabled function in the Clipping Plane zone must be checked to view the clipping plane.

The Clipping Plane zone provides the planar equation used to define the clipping plane. You can modify it
by providing new numerical values.

Alternatively, you can choose a cross-section plane in the Select the Plane zone:

• Select the desired cross-section plane in the drop-down list.

• Via the function Pick Plane, you can perform a cross-section starting with a plane directly selected
in the active viewport, using the eyedropper tool, or alternatively a precise cross-section point by
checking the Position option.

NOTE
The cross sections are represented automatically in the interactive view each time the
eyedropper tool is used.

Creating a Contour

The contour of the clipped surface edges can be visually represented by enabling the Show option within
the Contour zone. The color of the contour can be modified by clicking on the colored square to open the
color selector. You can also modify the thickness of the line by entering a numerical value, or by using
the up and down arrows of the keyboard.

Additional Display Options
The Plane box proposes a set of display options for the active cross-section plane.
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Thus the display of a plane can be activated (Plane zone > Show checkbox) and the value of its
transparency (Alpha field), size (Width and Height fields), orientation, and Color of its representation
(Color1 and Color2) can all be modified. Alternatively, just a metric Grid is displayed (Grid and Step
options).
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Measuring Tool
Available in: Shaper or Matter: Editors > Advanced > Measuring tool>

The Measuring Tool shows the distance between two points that you have chosen. This distance
between these two points may thus be represented visually in the active view.

TIP
The Show the gizmos option must be checked to use the eyedroppers.

• Click on the green eyedropper and select your starting point in the viewing window.

• Click on the yellow eyedropper and designate the end point in the scene.

The result is displayed in the Distance field of the Measure zone at the bottom of the editor.

TIP
The distance is represented visually.

The Enable Depth Test function allows you to show the gizmos measuring the distance between measur-
ing points in the scene without them being obscured by surfaces. Uncheck this parameter to display the
points and the measurement above all the surfaces.

Snapshot (Editor)
Access: Editors menu > Snapshot Image

From the Snapshot Editor, you can modify the rendering settings and render a view of a product to an
image file. This editor uses the material abilities of the interactive viewport to calculate an image whose
size can be significantly larger than the screen resolution. The maximum size of the image depends only
on your computer’s memory.

Once the desired settings have been indicated, the Render button initiates the creation of the image file.

Dimensions Zone
The dimensions and resolution for the image to be rendered are provided in the Dimensions zone.

The Format drop-down list provides access to the most common sizes and formats. Some, such as User
Defined or User Defined in Units allow the dimensions to be provided directly as values. By default, the
format Defined by view is proposed.
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The  button next to the Resolution box is a shortcut to standard resolutions expressed in dpi (dots
per inch). If the resolution is provided in units other than dpi, the chosen standard resolution will be
converted to the selected units.

In the Orientation zone, select one of the radio buttons for Portrait or Landscape. This choice is not
available if you have selected one of the predefined formats: Defined by Viewport, Defined by Product, or
Fill Viewport.

Rendering Engine Window
The Configure button in the Rendering Engine zone opens the OpenGL Parameters window.

Choose whether or not to apply:

• Antialiasing,

• mipmaps,

• Mirror Reflections,

• Transparent Background.

Choose the level of Super Sampling from the drop-down list.

Use the slider to define the level of Specular Anisotropic Filtering.

Click on OK to save your changes.

Files Zone
The Files zone contains the controls for creating an image file.
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In this zone you can set:

• The output directory where the image file will be saved, as well as the name of the file and its
extension,

• Whether to Open File Selector or not when rendering. When Open File Selector is selected, clicking on
the Render button will show the dialogue box offering the choice of file name and type. This option is
selected by default.
To change the format of the file to be created, change the extension of the file name. The following file
formats are supported for image output:
• .jpg

• .png

• .bmp

• .tif

• .exr

• .hdf

• .psd

• Whether to Confirm Overwrite or not when rendering. When Confirm Overwrite is selected, if a file
with an identical name is detected, a confirmation will be asked before replacing it with the file being
created. This option is selected by default.

• The configuration of the compression according to the file type,

• The configuration of the layered export for .psd files.

TIP
Images with an alpha layer must be saved as .png files to keep their transparency. In these
cases, the format PNG is automatically proposed by default.

Compression
Click the Configure Compression button to open the Compression window.

The compression can be adjusted for each file format for export. For each format, the higher the value is,
the better the quality will be.

• JPEG: slide the cursor to define the compression.

• PNG: slide the cursor to define the compression. Tick the Export as 16 bits checkbox if you want to
activate this option.

• Image Compression for Animations: slide the cursor to define the compression.

• Image Compression for VR Objects and Cubic VR Panoramas: slide the cursor to define the compres-
sion.

Layered Image Options
Click on the Configure Layered Export to open the Layered Image Options window. The settings defined
in this window apply to images exported as .psd files only.
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You can choose to export a layer for each of the following options:

• Composable Image containing three layers: a background, a multiplicative layer, and a layer of the
product’s opaque surfaces,

• Composited Image,

• G-Buffer,

• Wireframe,

• Z-Buffer,

• Lightmaps.

By default, only the Composable Image option is selected.

Snapshot Zone
The checkbox Show Info in the Snapshot zone provides the ability to display, along the bottom border of
the active viewport, a summary of the dimensions settings of the snapshot.

Internal Render Info Zone
The Internal Render Info zone summarizes various settings. The applicable elements from among
following information are displayed:

• Width of the image in pixels,

• Height of the image in pixels,

• Pass, the number of passes to render the image,

• Sampling,

• Memory.

Videos (Editor)
Access: Editors menu > Snapshot Video

The Video Editor exports a sequence of frames as a video file.

Starting from an initial observational point and a predefined animation scenario, the Video Editor calcu-
lates a frame for each stage of the camera’s animation path.

These various frames are assembled in a standard animation file using an AVI (Audio Video Interleave)
format, or alternatively saved individually as a sequence of images as .jpg, .png, .bmp, .tif, .exr, .hdf,
or .psd files.

Once the desired settings have been specified, the Render button launches the generation of the video
file.

Patchwork Explorer 2025 X8

35



TIP
During rendering, a dialogue box is displayed to show the progression of the creation of
the video file. The Viewer button at the bottom of this dialogue box opens a frame viewing
window.

At any time, you can pause the progression by clicking the Pause button, or cancel it by
clicking the Cancel button. If you have paused the rendering, start it again by clicking on
Resume.

Dimensions Zone
The dimensions of the animation to be rendered are filled out in the Dimensions box.

The Format drop-down lists the most common sizes and formats. Some, such as User-Defined, allow
you to directly set the dimension values. By default, the format Defined by Viewport is proposed.

Files Zone
The Files zone contains the controls for creating a video file.

In this zone you can set:

• The output directory where the image file will be saved, as well as the name of the file and its
extension,

• Whether to Open File Selector or not when rendering. When Open File Selector is selected, clicking on
the Render button will show the dialogue box offering the choice of file name and type. This option is
selected by default.

To change the format of the file to be created, change the extension of the file name. The following file
formats are supported for image output:

• .avi

• .png

• .jpg

• .bmp

• .tif

• Whether to Confirm Overwrite or not when rendering. When Confirm Overwrite is selected, if a file
with an identical name is detected, a confirmation will be asked before replacing it with the file being
created. This option is selected by default.

• Whether to Skip Existing Images or not,

• The configuration of the Codec according to the file type,

• The configuration of the compression.
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Rendering Engine Window
The Configure button in the Rendering Engine zone opens the OpenGL Parameters window.

Choose whether or not to apply:

• Antialiasing,

• mipmaps,

• Mirror Reflections,

• Transparent Background.

Choose the level of Super Sampling from the drop-down list.

Use the slider to define the level of Specular Anisotropic Filtering.

Click on OK to save your changes.

Snapshot Zone
The checkbox Show Info in the Snapshot zone provides the ability to display, along the bottom border of
the active viewport, a summary of the dimensions settings of the snapshot.

If ticked, the Viewer checkbox in the same zone sets the image viewing window to open automatically
during rendering.

Internal Render Info Zone
The Internal Render Info zone summarizes various settings. The applicable elements from among
following information are displayed:

• Width of the image in pixels,

• Height of the image in pixels,

• Pass, the number of passes to render the image,

• Sampling,

• Memory.

Frame Output Zone
You have the option to render only a portion of the timeline range by providing the numbers of the
desired frames:

• Current Frame,

• All Frames,

• A Range of frames.

It is also possible to indicate the initial number for the index appended to the filename of each frame in
the Output Filename zone. By default, the value of this option is "0."
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Camera Path Zone

Rotor Type
A Rotor type camera path makes the camera orbit an object. The selection of this type of camera path
displays the Rotor zone below the Camera Path zone.

The rotor creates a vertical axis of rotation on the Y axis. The product in the viewport rotates around this
axis in accordance with the parameters that you provide:

Setting Definition
Frame rate The number of frames per second.
Loop The preview of the animation plays in a loop.
Real Time The preview of the animation is in real time.
Center The position of the camera in height and in distance from the Y axis can be reset.

The camera is initially positioned by default. Use the navigation tools to modify the
viewport camera position, then click on the button Center to use the new camera
position and to define the current viewport view as the rotor’s initial position.

Duration The duration of the animation in seconds.
Ping Pong The definition of the width of the arc of the camera path. You can:

• Have the camera cover an arc with a back-and-forth motion by ticking the Ping
Pong checkbox. Then supply the width of the camera’s arc in degrees.

• Have the camera complete a full rotation by leaving the Ping Pong checkbox
unchecked.

Kam File Type
If you have selected Kam File as your camera path, the scene will be animated according to an
existing animation path, which might have been created, for example, by the export of a bookmark
animation [39] as a .kam file. The Kam Files options are displayed in the Camera Animations editor.

In the box File you have access to the tools to:

Icon Function
Import Kam File

Update Kam File

Export Kam Animation

Delete Kam Animation

In the Parameters zone, the Filename and the number of Frames are displayed for your information.
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You can also choose to Flip Fov Aspect (switch between horizontal and vertical “field of view” values) or
to Ignore Fov Value supplied by the .kam file.

Bookmark Animator Type
The Bookmark Animator type allows you to define a camera path passing by one or more animation
bookmarks that you set up in the animator. You establish the order of the bookmarks, the time spent at
each point, and the type of animation used to move from one point to another.

NOTE
The animation bookmarks and the favorite cameras set up in Patchwork 3D Enterprise or
Patchwork 3D Engineering are separate types of camera position bookmarks that should
not be confused.

To create an animation, start with the Animation zone. You can create multiple paths or “animations.” To
create a new animate or add a first animation, use the buttons:

Icon Function
New Bookmark Animation

Duplicate Bookmarks Animation

Import Bookmark Animation

Export Bookmark Animation

Delete Bookmark Animation

The Time Parameters zone concerns the global duration of the animation. Define the pauses between
bookmarks and the duration of each bookmark. The Total Time of the animation is calculated based on
this information.

Tick the Close Path checkbox to animate the transition between the last and the first bookmarks when
the animation playback is looped. This option is checked by default.

The Bookmark Sequence zone summarizes the animation bookmarks according to their order in your
animation list. It also provides the information concerning each bookmark as a step in the animation.

This zone offers multiple buttons to modify the list of bookmarks:

Icon Function Description
New Animation
Bookmark

Adds the current viewport's view of the product to your list as
a new animation bookmark.

Update Animation
Bookmark

Replaces the selected bookmark with the current view of the
product.
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Icon Function Description
Duplicate Animation
Bookmark

Creates a bookmark identical to the selected bookmark and
adds it to the end of the list.

Move Bookmark Up in
List

Moves the selected bookmark to position it higher in the list.

Move Bookmark Down
in List

Moves the selected bookmark to position it lower in the list.

Delete Animation
Bookmark

Removes the bookmark from the list. Its settings will not be
saved.

Bookmark
The Bookmark zone concerns the set-up of the selected bookmark:

Parameter Description
Checkbox Includes the bookmark in the animation (checked) or excludes it (unchecked).
Label Allows you to set or modify the name of the bookmark.
Sleep Defines the duration of the pause of the bookmarked image.
Duration Defines the duration of the animated transition to the next bookmark.
Smoothness Sets the fluidity of the camera behavior.
Type Type of path:

• Linear: sets a straight path (the rotation parameter fields are grayed out),

• Jump: moves from one stage to the next with no transition,

• Orbit: sets a circular path (the rotation parameter fields are accessible),

• Head: pivots the camera (the rotation parameter fields are accessible),

• Spline: smooths the transitions when the camera moves from bookmark to
bookmark.
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Parameter Description
Orbit/Head Provides rotation parameters, which are modifiable if you have selected Orbit or

Head as the type):

• During... of step: percentage of the step dedicated to the rotation,

• turn…times: number of 360-degree turns to carry out.

TIP
Several types of paths can be set up in the Bookmark zone.
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VR Object Editor
Access: Editors menu > Snapshot VR Object

The VR Object Editor produces a 3D image of the product. In this 3D image, the camera is stationary. The
object is posed on a plane that turns at regular intervals of time. This allows you to view the object from
every angle, with the ability to examine every detail.

Once the desired settings have been indicated, the Render button initiates the creation of the image files
that constitute the VR object.

TIP
During rendering, a dialogue box is displayed to show the progression of the creation of
the VR object files. At any time, you can pause the progression by clicking the Pause
button, or cancel it by clicking on the Cancel button. If you have paused the rendering, start
it again by clicking on Resume.

The Viewer button at the bottom of this dialog box opens a window for viewing captures.

Dimensions Zone
The dimensions of the animation to be rendered are filled out in the Dimensions box.

The Format drop-down lists the most common sizes and formats. Some, such as User-Defined, allow
you to directly set the dimension values. By default, the format Defined by Viewport is proposed.

Files Zone
The Files zone contains the controls for creating a VR Object.

In this zone you can set:

• The output directory where the image file will be saved, as well as the name of the file and its
extension,

• Whether to Open File Selector or not when rendering. When Open File Selector is selected, clicking on
the Render button will show the dialogue box offering the choice of file name and type. This option is
selected by default.

TIP
VR objects are saved in the Snapshots directory by default.

To change the format of the file to be created, change the extension of the file name. The following file
formats are supported for image output:

• .jpg
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• .png

• .bmp

• .tif

• .exr

• .hdr

• .psd

Whether to Confirm Overwrite or not when rendering. When Confirm Overwrite is selected, if a file with
an identical name is detected, a confirmation will be asked before replacing it with the file being created.
This option is selected by default.

The configuration of the compression. Slide the Image compression for VR Objects and Cubic VR
Panoramas to define the compression. A higher value will yield a better quality.

Rendering Engine Window
The Configure button in the Rendering Engine zone opens the OpenGL Parameters window.

Choose whether or not to apply:

• Antialiasing,

• mipmaps,

• Mirror Reflections,

• Transparent Background.

Choose the level of Super Sampling from the drop-down list.

Use the slider to define the level of Specular Anisotropic Filtering.

Click on OK to save your changes.

Snapshot Zone
If ticked, the Viewer checkbox in the same zone sets the image viewing window to open automatically
during rendering.

Internal Render Info Zone
The Internal Render Info zone summarizes various settings. The applicable elements from among
following information are displayed:

• Width of the image in pixels,

• Height of the image in pixels,

• The number of Frames to render,

• Pass, the number of passes to render the image,

• Sampling,
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• Memory.

Preview Frame Zone
The Preview Frame zone allows you to preview each frame of the camera’s path around the object by
moving the slider along the bar.

This preview allows you to check the point of observation. By default, the product is observed with a very
large field of view. You can modify the point of observation at any time, either in the active viewport or
with the tools in the Camera Path [44] zone. To apply a modification to the point of observation, click
the Acquire button in the Camera Path zone.

Camera Path Zone
The Camera Path Zone defines the camera’s position and its path.

To create a VR object, a series of images is generated, in which each image is taken from a point on a
circle around a central point. Center values are used to position this central point relative to the origin of
the coordinate system. The Radius value establishes the distance between the camera and this central
point.

The value FovY in degrees provides the vertical field of view.

If you have made changes, click on the Acquire button in order to validate and apply these settings.

VR Object Settings
The VR object settings establish:

Setting Description
Pan Range Frames can be created either for a complete circle on a horizontal plane (the

checkbox Complete Loop is ticked by default) or for a limited arc only. In this latter
case, you must supply the angles between which your product will be observed.

Tilt Range Frames can be created to form a circle on a horizontal plane around the camera
path’s central point or to form a sphere or portion of a sphere around this same
point. In these latter cases, you must supply the angles between which your product
can be viewed. By default, the camera angles cover a full sphere. The viewing angles
range from -90 degrees (the negative Y axis) to +90 degrees (the positive Y axis).

Number of
Frames

Frames can be created closer together or farther apart along the camera path. Pan
provides the number of frames along the circle on the horizontal plane. Tilt provides
the number of frames between the top and bottom angles, if you have defined a
vertical plane.

Cubic VR Panorama Editor
Access: Editors menu > Snapshot Cubic VR Panorama
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Cubic VR Panorama produces a 3D image of the product in a 3D space. It creates a cubic viewing space
that gives the observer the impression to be in the product’s 3D space.

Once the desired settings have been indicated, the Render button initiates the creation of the image files
that constitute the cubic VR panorama.

TIP
During rendering, a dialogue box is displayed to show the progression of the creation of
the video file. At any time, you can pause the progression by clicking the Pause button, or
cancel it by clicking on the Cancel button. If you have paused the rendering, start it again
by clicking on Resume.

The Viewer button at the bottom of this dialogue box opens a frame viewing window.

Dimensions Zone
The dimensions in pixels of the cubic VR panorama to be rendered are provided in the Dimensions zone.

Files Zone
The Files zone contains the controls for creating a VR Object.

In this zone you can set:

• The output directory where the image file will be saved, as well as the name of the file and its
extension,

• Whether to Open File Selector or not when rendering. When Open File Selector is selected, clicking on
the Render button will show the dialogue box offering the choice of file name and type. This option is
selected by default.

TIP
VR objects are saved in the Snapshots directory by default.

To change the format of the file to be created, change the extension of the file name. The following file
formats are supported for image output:

• .jpg

• .png

• .bmp

• .tif

• .exr

• .hdr

• .psd
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Whether to Confirm Overwrite or not when rendering. When Confirm Overwrite is selected, if a file with
an identical name is detected, a confirmation will be asked before replacing it with the file being created.
This option is selected by default.

The configuration of the compression. Slide the Image compression for VR Objects and Cubic VR
Panoramas to define the compression. A higher value will yield a better quality.

Rendering Engine Window
The Configure button in the Rendering Engine zone opens the OpenGL Parameters window.

Choose whether or not to apply:

• Antialiasing,

• mipmaps,

• Mirror Reflections,

• Transparent Background.

Choose the level of Super Sampling from the drop-down list.

Use the slider to define the level of Specular Anisotropic Filtering.

Click on OK to save your changes.

Snapshot Zone
If ticked, the Viewer checkbox in the in the Snapshot zone sets the image viewing window to open
automatically during rendering.

Click on Background to open the color selector. The selected color will be used as a background in the
rendering.

Internal Render Info Zone
The Internal Render Info zone summarizes various settings. The applicable elements from among
following information are displayed:

• Width of the image in pixels,

• Height of the image in pixels,

• Pass, the number of passes to render the image,

• Sampling,

• Memory.
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FAVORITE CAMERAS

Access: Product menu > Restore favorite camera...

Favorite cameras established in Patchwork 3D Enterprise or Patchwork 3D Engineering are available
in Patchwork Explorer. The Restore favorite camera… options load the camera settings in the active
viewport.

Favorite cameras are also used in the Cameras [22] tab of the Product Manager editor.
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REQUIRED HARDWARE

NOTICE
The hardware described below may not be compatible with your software edition: Com-
munity, Premium, Essential, or Enterprise.

64-bit Architectures
Patchwork Explorer runs on 64-bit architectures.

Minimal Configuration
Operating system: Windows 10 ×64 or newer.

Processor: Intel Pentium Core i5 Sandy Bridge or higher, AMD Athlon II X4 or higher.

RAM: 8 GB, 16 GB for raytracing.

Workstation Laptop
Quadro M6000 (12 GB)

Quadro M5000 (8 GB)

Quadro M4000 (8 GB)

Quadro M5100M (8 GB)

Quadro M5000M (8 GB)

Quadro M4000M (4 GB)

Quadro M2000M (4 GB)

NOTE
Graphics cards must be used with the latest certified NVIDIA® drivers.

Recommended Configuration
Operating system: Windows 10 ×64 or newer.

Processor: Intel Core i7 Haswell or higher, AMD Bulldozer or higher.

RAM: 16 GB, 24 GB for raytracing with large scenes, and processor with at least 8 cores.
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Workstation Laptop
RTX A6000 (48 GB)

RTX A6000 (24 GB)

RTX A5000 (24 GB)

RTX A5500 (24 GB)

RTX A4500 (20 GB)

RTX A4000 (16 GB)

RTX A2000 (12 GB)

RTX A2000 (6 GB)

RTX A5500 (16 GB)

RTX A5000 (16 GB)

RTX A4500 (20 GB)

RTX A4000 (16 GB)

RTX A3000 (12 GB)

Quadro RTX 8000 (48 GB)

Quadro RTX 6000 (24 GB)

Quadro RTX 5000 (16 GB)

Quadro RTX 4000 (8 GB)

Quadro RTX 3000 (6 GB)

Quadro GV100 (32 GB)

Quadro GP100 (16 GB)

-

Quadro P4000 (8 GB) -

NOTE
Graphics cards must be used with the latest certified NVIDIA® drivers.
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